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Abstract 
 
Adults are impossible to imagine without a mobile phone nowadays. And the 
trend shows that more and more handheld devices are integrating wireless 
communication features like Wireless Lan, Bluetooth and Infrared. Establishing a 
delay tolerant communication network using the wireless communication ability 
of handhelds in order to distribute content is one of the projects of the 
Communication Systems Group at the ETH. 
 
Using the air traffic network as a backbone for the delay tolerant network is one 
approach. In this thesis the static characteristics of the air traffic network over 
Europe are analyzed and so on a fundament for further dynamical statistics 
research is build. 
 
A flight schedule and a flight record over Europe build the data collections which 
are parsed and transformed into a common Pajek [8] network file format. 
 
In Pajek, software to analyze and illustrate large networks, static characteristics 
like indegree, outdegree and line value distributions are calculated and plotted. 
 
In analyzing the distributions of these static characteristics we find out whether 
the network is random or scale-free. 
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1 Introduction 
 
Nowadays well established communication networks relay on continuous end-to-
end connectivity (Internet, Telephony System). But many handheld devices like 
the mobile phone, organizers, cameras etc. have the ability to establish a 
communication line to another handheld device over a wireless link. The 
characteristic of such a link is influenced by the human mobility. Wireless devices 
can be used to let content distribute in a peer-to-peer manner when mobile 
users interact. Opportunities to transfer content occur when a lot of people are 
interacting, such as in public transportations, cinemas, libraries and in spots 
which are occupied by humans in general. 
 

1.1 Delay Tolerant Networks 
 
A communication is established when information from a source to a destination 
is transferred. Therefore a communication network must have the ability to 
transport data from a source to a destination. The wired Internet has an 
underlay with an instantaneous end-to-end path. Popular ad hoc routing 
protocols try to establish a complete route and transfer the actual data. In a 
wireless communication network with mobile users it is difficult or impossible to 
establish an end-to-end path. In order to distribute data in such a network, the 
data has to be stored and forwarded to linked mobile devices in the hope that it 
will eventually reach its destination. In order to maximize the probability of a 
successful message transfer to a destination a frequently used technique is to 
replicate many copies of this message and hope that one will arrive at the 
destination [1]. 
 

1.2 Message Ferrying via Air Traffic Network 
 
Message Ferrying Mediums [2] are tracking prescribed traces and interacting 
with Data Mules in order to assure content dissemination. Data Mules are devices 
which are collecting or distributing data autonomously without any predefined 
traces. Inhere Data Mules are mobile devices and Message ferrying Mediums are 
airlines. If one or more mobile users from one agglomeration want to send a 
content to one or more mobile users from another agglomeration and if there is 
no direct link using mobile devices the link could be established with airlines. The 
Air Traffic Network is used as an underlay for the Delay Tolerant Network [3]. 
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1.3 Goals 
 
The goals of this semester thesis are: 
 

• Represent the Air Traffic Network as a Graph 
 
• Determine static characteristics of the Air Traffic Network 

 
• Build a basis for prospective research 

 

1.4 Outline 
 
The subsequent chapters are organized as follows. In the second chapter a short 
introduction in to graph theory which is used to model the Air Traffic Network is 
given. Chapter 3 presents the data collections which are present and how they 
are structured. In Chapter 4 basic properties of Pajek, software to analyze and 
visualize Large Networks, are covered. Chapter 5 explains in a generalized logic 
how the data collections are parsed and transformed in order to use them with 
Pajek. In Chapter 6 the results obtained analyzing the Air Traffic over Europe 
with Pajek are shown.  
A conclusion and an outlook build the content of Chapter 7. 
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2 Air Traffic Network as a Graph 
 
This Chapter illustrates how the Air Traffic Network is modeled as a Graph and 
how the characterizations are defined. 
 

2.1 The Graph Model 
 
A graph is a set of vertices (nodes) and a set of lines between pairs of vertices. 
 
In the Analysis of the Air Traffic Network a vertex represents an airport and a 
line an air flight between two airports. 
 
A line in a graph is directed or not directed. A directed line is called an arc and 
an undirected line is an edge. A graph which contains at least one arc is a 
directed graph and a graph which contains only edges (no arcs) is an undirected 
graph. 
An air flight from an airport A to an airport B does not necessarily imply an air 
flight from airport B to A and vice versa. Therefore an air flight is represented 
with an arc. 

 
Figure 2-1: Air Traffic Network Graph 
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The graph of the Air Traffic Network is directed. 
 
In Figure 2-1 a model of the Air Traffic Network is shown how it can look like as 
a graph. The three letter codes [4] represent the abbreviations of the airports. 
MSQ stands for Minsk and VKO for Moskav Vnukovo. The numbers printed on the 
arcs offer additional information. They represent the number of connections in a 
time period and are also designated as arc weight. Let us have a look to air 
flights between Zurich (ZRH) and Minsk (MSQ). There are 8 air flights from 
Zurich to Minsk and 3 air flights from Minsk to Zurich. This fact states the 
explanation that an air flight has not to be reversed. 
 

2.2 Graph Metrics 
 
In this subchapter some graph metrics are explained which are used to obtain 
the characteristics of the Air Traffic Network. 
 
Degree: 
The Degree of a vertex (airport) is the number of lines incident with it. 
 
Indegree: 
The Indegree of a vertex is the number of arcs it receives. 
 
Outdegree: 
The Outdegree of a vertex is the number of arcs it sends. 
 
Example: In Figure 2-1 the airport in Istanbul has an indegree of 4 and an 
outdegree of 5. 
 
Two airports are adjacent if they are connected by a line (arc or edge). 
 
Walk: 
A walk from airport UUU to airport VVV is a sequence of arcs such that the end 
Airport of one air flight is at its tail and the starting airport of the next air flight is 
at its origin. The sequence starts at airport UUU and ends at airport VVV. 
 
Path: 
A path is a walk in which no airport in between the first and last airport of the 
walk occurs more than once 
 
Geodesic: 
A geodesic is the shortest path between two airports. 
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Distance: 
The distance from airport UUU to airport VVV is the length of the geodesic 
(counting number of arcs) from UUU to VVV. 
 
Diameter: 
The Diameter is the length of the longest shortest path in a network. 
 

2.3 Random and Scale-Free Networks 
 
A random network [5] is generated by some random process. The most known 
model is the Erdõs-Rényi model. In this model a set of n vertices is given and 
with a probability of p an edge respectively an arc occur indepently. It is obvious 
that in such a model a graph can be constructed which is not connected. 
 
The degree distribution of a scale free network [6] shows a power law like many 
real networks. The similarity of vertices with a degree which exceeds greatly the 
average is a main characteristic of scale free networks. The highest degree 
nodes are often called hubs. In scale free networks the major hubs are closely 
followed by smaller ones and these again by vertices with even smaller degrees. 
This property allows for a good connectedness when edges or arcs drop out. 
 

 
Figure 2-2: Random and Scale-Free Networks 
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3 Data Collections 
 
In order to represent the Air Traffic Network as a graph a record of air flights or 
a flight schedule is needed. 
 
Following companies and institutes have been requested for flight schedules and 
records: 

 OAG Travel Information  www.oag.com 
 FlyteComm  www.flytecomm.com 
 FlightAware  www.flightaware.com 
 Flughafen Zürich AG  www.unique.ch 
 EUROCONTROL European Organisation for the Safety of Air 

Navigation  www.eurocontrol.com 
 Institute for Transport Planning and Systems  www.ivt.ethz.ch 
 A community of Radar Box owners exists, which track individually 

flights and collect them.  www.openatc.com 
 
The Institute for Transport Planning and Systems (short IVT) delivered a flight 
schedule and EUROCONTROL delivered a flight record. 
 

3.1 Data Collection from the IVT 
 
The IVT delivered a flight schedule for a whole week covering all European 
flights in 2006. The flight schedule is stored in the file 
Flugverbindungen.att. The airports are coded as numbers. The relevant 
airports and their geographical coordinates can be found in the file 
Knotenliste.att.  
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Above a snapshot of the file Flugverbindungen.att is shown. The Schedule 
starts at the line with the label 1. 
In one row following informations are listed tab separated (Line 1 as example in 
Brackets): 

Departure Time  (07:15:00) 
Arrival Time (08:00:00) 
Departure Airport (40340) 
Arrival Airport (40333) 
Flight Code (0D 010 _ H >) 
Tuesday (1) 
Thursday (1) 
Friday (1) 
Wednesday (1) 
Monday (1) 
Saturday (0) 
Seats (0) 
Sunday (0) 

 
A one by the weekdays indicates that the flight will take off at that day a zero 
that it will be not take off. The Label “Seats” is not relevant for this thesis. 
 

 
 
Above a snapshot of the file Knotenliste.att is shown.  

1 07:15:00 08:00:00 40340 40333 0D 010 _H > 1 1 1 1 1
 0 0 0 
2 08:35:00 09:25:00 40333 40340 0D 011 _H > 1 1 1 1 1
 0 0 0 
3 10:45:00 11:35:00 40340 40333 0D 014 _H > 1 1 1 1 1
 1 0 1 
4 12:35:00 13:25:00 40333 40340 0D 015 _H > 0 0 0 0 0
 1 0 1 
5 16:35:00 17:25:00 40333 40340 0D 017 _H > 1 1 1 1 1
 0 0 0 
6 18:15:00 19:05:00 40340 40333 0D 018 _H > 1 1 1 1 1
 0 0 1 
7 19:35:00 20:25:00 40333 40340 0D 019 _H > 1 1 1 1 1
 0 0 1 
8 09:10:00 10:25:00 40423 40340 0D 151 A _H > 1 1 1 1 1
 0 0 0 
............ 
............

40001 IVL Ivalob 737137.6875 1913630.0000 FI IVL 
40002 ENF Enontekioe 581974.1875 1858523.0000 FI ENF 
40003 KTT Kittilae 645208.5000 1784889.0000 FI KTT 
40004 KRN Kiruna 447395.5000 1766883.0000 SE KRN 
40005 GEV Gaellivare 480020.5000 1692137.0000 SE GEV 
40006 RVN Rovaniemi 717375.8125 1667027.0000 FI RVN 
40007 KAO Kuusamo 882537.8125 1635637.0000 FI KAO 
40008 KEM Kemi-Tornio 677715.8750 1569113.0000 FI  
40009 LLA Luela - Kallax 569095.8125 1523420.0000 SE LLA 
40010 AJR Arvidsjaur 427456.9063 1510933.0000 SE AJR 
.................................... 
.................................... 
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In one row following informations are listed tab separated (Line 40001 as 
example in Brackets): 

Airport No (40001) 
World Airport Code (IVL) 
Name of the Airport (Ivalob) 
X-Coordinate (737137.6875) 
Y-Coordinate (1913630.000) 
Country code (FI) 
World Airport Code (IVL) 
 

Both data files above are extracted from Visum [7] a traffic platform. The 
coordinates of the airports are coded for use in Visum as well. 
 

3.2 Data Collection from EUROCONTROL 
 
Eurocontrol delivered a record of all flights for the all days of November 2007. 
Below you can find a snapshot of one of the data files.  
 

 
 
In one row following informations are listed tab separated (first line 40001 as 
example in Brackets): 

Flight Identifier (0059124420071101) 
Departure Airport (LZKZ) 
Arrival Airport (LZIB) 
Planned Departure Date and Time 01.11.2007 00:04:00 
Actual Departure Date and Time 01.11.2007 00:04:00 
Planned Arrival Date and Time 01.11.2007 00:36:15 
Actual Arrival Date and Time 01.11.2008 00.43:25 

 
The airports and flight numbers from Eurocontrol are anonymous. 
 
 

0059124420071101  LZKZ LZIB 01.11.2007 00:04:00 01.11.2007 00:04:00
 01.11.2007 00:36:15 01.11.2007 00:32:45 
0059402220071101  ESSA ESOK 01.11.2007 00:15:00 31.10.2007 23:58:00
 01.11.2007 01:01:10 01.11.2007 00:43:25 
0060588220071101  EHKD ZZZZ 01.11.2007 00:10:00 01.11.2007 00:10:00
 01.11.2007 00:33:45 01.11.2007 00:33:45 
0061217920071101  EDDK LFPG 01.11.2007 00:10:00 01.11.2007 00:22:55
 01.11.2007 00:46:40 01.11.2007 01:00:00 
0061580720071101  EDDF EDDT 01.11.2007 00:15:00 01.11.2007 00:14:00
 01.11.2007 01:02:55 01.11.2007 00:54:25 
0061670220071101  EHKV EHKD 01.11.2007 00:15:00 01.11.2007 00:15:00
 01.11.2007 00:32:55 01.11.2007 00:32:55 
........................................... 
........................................... 
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3.3 Differences between the Data Collection from IVT and 
Eurocontrol 

 
In this thesis the results of analyzing the data collection from IVT are shown.  
The advantage over the data collection from Eurocontrol is that the airports and 
flights are identified and it is easier to demonstrate and bring them into relation 
with the real world. 
Another fact is that the IVT delivers a flight schedule and Eurocontrol a flight 
record. In the data set from Eurocontrol also flights are recorded which are not 
accessible for everybody. These flights are not always usable for distributing 
information over handhelds. Also flights are recorded which start and end at the 
same airport. 
 

 Airports Flights 
IVT 487 5227 
Eurocontrol 2220 50155 

Table 1: Differences IVT and Eurocontrol Vertices and Lines 
 
Anyhow the data collection from Eurocontrol is parsed, transformed to Pajek-file 
representation and the results are represented in Appendix C. 
 
In the next chapter the use of the network analysis software Pajek is described. 
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4 Pajek Analysis and  
Visualization of Large Networks 

 
Pajek [8] is a free software running under Windows in order to analyze and 
visualize networks with a thousand even million of nodes. Once a network is 
described in Pajek you have many opportunities to analyze graph matrices and 
let them compute. In this chapter the commands and utilities which have been 
used to visualize and analyze the Air Traffic Network are shown. 
 

4.1 The Network Data Format in Pajek 
 
There are several ways to type in a Network in Pajek. You can do it manually by 
creating a new .net file via the File>Network>Read command in Pajek and then 
typing in the number of vertices and adding lines to the net after drawing the 
vertices with Draw>Draw. 
 
The method used in this semester thesis is to generate the *.net file with C++ 
after parsing the original data collection from the IVT. 
At the next page an example of a network file with 20 vertices and 31 arcs is 
illustrated. 
The first line is followed by a list of vertices. Each line is containing the vertex 
number, the vertex label, which is here the letter v followed by a number by 
default and the x, y and z coordinates of the vertex in a drawing. 
The line *Arcs indicates the start of the list of arcs. At the next line the first 
number indicates the starting vertex and the second number the ending vertex 
of an arc. The third number is indicating the value of the arc. 
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4.2 Putting Coordinates 
 
In our data collection from the IVT coordinates of the airports are also included. 
This coordinates are parsed and saved in the two vector files 
x_coordinates.vec and y_coordinates.vec. 
Each line in these files describes a coordinate for the vertex with the 
corresponding number. Executing the command Operatios>Vectors>Put 
Coordinate for each .vec file will set the coordinates. 

*Vertices      20 
       1 "v1"                                     0.1000    0.5000    0.5000 
       2 "v2"                                     0.1196    0.3764    0.5000 
       3 "v3"                                     0.1764    0.2649    0.5000 
       4 "v4"                                     0.2649    0.1764    0.5000 
       5 "v5"                                     0.3764    0.1196    0.5000 
       6 "v6"                                     0.5000    0.1000    0.5000 
       7 "v7"                                     0.6236    0.1196    0.5000 
       8 "v8"                                     0.7351    0.1764    0.5000 
       9 "v9"                                     0.8236    0.2649    0.5000 
      10 "v10"                                    0.8804    0.3764    0.5000 
      11 "v11"                                    0.9000    0.5000    0.5000 
      12 "v12"                                    0.8804    0.6236    0.5000 
      13 "v13"                                    0.8236    0.7351    0.5000 
      14 "v14"                                    0.7351    0.8236    0.5000 
      15 "v15"                                    0.6236    0.8804    0.5000 
      16 "v16"                                    0.5000    0.9000    0.5000 
      17 "v17"                                    0.3764    0.8804    0.5000 
      18 "v18"                                    0.2649    0.8236    0.5000 
      19 "v19"                                    0.1764    0.7351    0.5000 
      20 "v20"                                    0.1196    0.6236    0.5000 
*Arcs 
1 2 4 
1 8 8 
1 6 3 
1 15 10 
1 20 7 
20 3 9 
2 1 4 
4 5 2 
1 5 9 
3 4 12 
5 9 17 
4 20 12 
4 9 32 
18 12 49 
17 14 23 
7 20 12 
14 9 32 
9 12 7 
12 18 87 
10 11 43 
12 7 1 
13 9 12 
9 12 12 
17 12 1 
18 12 23 
6 7 12  
18 19 2 
19 2 13 
15 18 34 
5 10 31 
11 13 9 
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4.3 Computing Graph Metrics 
 
In order to compute graph metrics the corresponding graph should be read in 
Pajek. (File>Network>Read) 
 
Indegree: 
Net>Partitions>Degree>Input 
After executing this command a partition file with the ending .clu listing the 
Indegree of each vertex in the corresponding line can be saved. 
File>Partition>Save  
 
Outdegree: 
Net>Partitions>Degree>Output 
After executing this command a partition file with the ending .clu listing the 
Outdegree of each vertex in the corresponding line can be saved. 
File>Partition>Save  
 
Average distance among reachable pairs and most distant vertices: 
Net>Paths between 2 Vertices>Distribution of Distances>From All Vertices 
After executing this command a vector file with the ending .vec listing the 
amount of pairs with a specific distance can be saved. The distance is computed 
disregarding the line values, only the number of hops is counted. 
 
Diameter: 
Net>Paths between 2 Vertices>Diameter 
Notice that the diameter is defined as the longest shortest path between two 
vertices. 
 
Shortest path between 2 Vertices 
Net>Paths between 2 Vertices>One Shortest or All Shortest 
With the command above one shortest path or all shortest path between two 
vertices can be computed. Even the line (arc) values can be considered in the 
computation of the shortest path. You have to type in the start and end vertices 
using the vertex number or label. After executing this command a network 
containing only the vertices and arcs of the shortest path or paths and a partition 
containing the vertices of the shortest path or paths in one class and the rest of 
the vertices in another class will be generated. 
 
Distance from/to one vertex to/from all other vertices 
Net>k-Neighbours>Input/Output 
This command will compute the distance from/to one vertex to/from all other 
vertices and create a partition of classes containing the distances between one 
vertex and all other vertices. 
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Distribution of line values 
Info>Network>General 
This command lists line values and the corresponding line connections in the 
form ZRH.IST 
Info>Network>Line Values 
Identifying the number of clusters or intervals of line values a distribution of line 
values is listed on the Report window. 
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5 Parsing and Generating Network Files 
 
This chapter explains sketchily how to solve the issue of transforming the data 
collections from the IVT and Eurocontrol into Pajek compatible .net files. For a 
detailed comprehension it is recommended to have a look at the commented 
C++ codes on the enclosed CD. 
 

5.1 Transforming the Data Collection from IVT 
The Figure 5-1 shows step for step which processes have been done on the data 
collection from the IVT in order to transform it into a Pajek file, which can be 
worked on. Each square represents a step. Squares labeled with a C++ file 
contain an abstract pseudocode which describes what the code executes. For 
detailed description please open the C++ file on the CD and read the commands. 
Squares labeled with Word Pad or Pajek describe steps wich has been made in 
these programs. 
 

5.2 Transforming the Data Collection from Eurocontrol 
 
Eurocontrol delivered a set of daily flight schedules of the whole November 2007. 
All the airports are made anonymous and there is no airport list available. The 
C++ file compiled program of eurocontrol.cpp is looking through the whole 
flight schedule and extracting an airport list which is stored in*Vertices format to 
eurocontrol.net. After that all the flight schedules are again analyzed and an arcs 
list representing air flights is constructed. The result is the eurocontrol.net file 
with a list of vertices and arcs. For a detailed explanation please look at the 
command on eurocontrol.cpp. 
The eurocontrol.net file can be used for further analysis on the data collection 
from Eurocontrol in Pajek. 
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Figure 5-1: Transforming Data Collection from IVT 
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6 European Air Traffic 
 
After transforming the data collection from the IVT with the processes described 
in chapter 5 it can be worked on the European Air Traffic Network using Pajek. 
In this chapter the results using the opportunities of Pajek described in Chapter 4 
are presented. 
 

6.1 The Graph 
 
In Pajek after opening the airportgraphsuminv.net file 
([Main]File>Network>Read) it can be let draw with the clicking 
[Main]Draw>Draw. 
The Graphes are illustrated in the Appendix A because of their size. It is 
recommended to have a look at the Figures opening them at the Computer. 
Figure A-1 represents the European Air Traffic Network with the arcs weighted 
by number of flights per week. There are a lot of airports which are not 
connected with other airports.  
 

6.2 Indegree 
 
After computing the indegree partition the distribution of the indegree is 
computed with the command [Main]Info>Partition 
A distribution list can be found in the file Input Degree Partition.txt . 
It is remarkable that 55.6 % of the airports have an input degree of zero, which 
indicates no approaching airplanes. Amsterdam with 104, Munich with 103 and 
Frankfurt with 101 are the most approached airports in Europe. Zurich with an 
indegree of 72 occupies the 17th position. 
Figure 6-1 illustrates the indegree distribution. (In the appendix B a bigger size 
of figure 6-1 can be found.). The amount of airports belonging to a fixed degree 
decreases when the related degree increases. 
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Indegree Distribution

271
13 14 11 4 7 7
10 8 7 6 4 4 5 4 7 3 3 1 3 6 3 3 3 4 2 4 1 1 2 1 4 1 6 1 3 2 1 2 1 2 2 1 2 2 1 1 1 2 1 1 1 1 3 1 1 2 1 1 1 2 1 2 1 2 1 2 1 1 1 1 1

0

50

100

150

200

250

300

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32 33 34 35 36 37 38 40 41 42 43 44 45 46 48 50 52 53 54 55 60 62 64 65 66 67 69 72 73 77 78 79 82 83 85 90 98 101
103
104

Indegree

A
m

ou
nt

 o
f A

irp
or

ts

 
Figure 6-1: Indegree Distribution Amount of Airports 

 
Figure 6-2 shows the cumulated percentage of airports with increasing 
indegrees. The logarithmic shape of the curve is conspicuous. 
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Figure 6-2: Cumulated Indegree Distribution as Percentage 
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7.8 Outdegree 
 
A distribution list can be found in the file Output Degree Partition.txt . 
Similar to the statistics of the indegree 55.6 % of the airports have an output 
degree of zero, which indicates no departing airplanes. Amsterdam with 103, 
Munich with 102 and Frankfurt with 101 are the most departed airports in 
Europe. Zurich with an outdegree of 72 occupies again the 17th position. 
Figure A-4 illustrates the outdegree distribution graphically. 
 
The characteristics of the figures 6-3 and 6-4 are similar to the figures of the 
indegree distribution. The logarithmic shape is again detectable. 
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Figure 6-3: Outdegree Distribution Amount of Airports 
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Figure 6-4: Cumulated Outdegree Distribution as Percentage 

 

7.9 Distribution of Distances 
 
There are in total 190242 pairs of Airports which are not connected through a 
flight. 
 

Distance Amount of Pairs 
1 5227 
2 28709 
3 12338 
4 166 

Table 2: Distribution of Distances 
 
The average distance among reachable pairs amounts to 2.16027. 
 
The diameter has a value of 4. The distance between the airports OUL (Oulu in 
Finnland) and CND (Constanta in Romania) is one representant for the Diameter. 
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Figure 6-5: Diameter OUL to CND 

 
Considering the values on line during the computation of the shortest path an 
amount of 5 hops is obtained from OUL to CND. The line values are the inversed 
number of flights between the two airports. The computation of a shortest path 
in Pajek indicates the path with the most frequent air flights from one airport to 
an other airport. 
The sum of the line values is 0,4. 
 

 
Figure 6-6: Shortest Path from OUL to CND considering line values 
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7.10 Distribution of Distances from Zurich 
 
Frequency distribution of cluster numbers: 
 
 Cluster      Freq     Freq%    Valid%  CumFreq  CumFreq% CumValid% Representative 
 ---------------------------------------------------------------------------------- 
       0         1    0.2053    0.4630        1    0.2053    0.4630 ZRH 
       1        72   14.7844   33.3333       73   14.9897   33.7963 HEL 
       2       140   28.7474   64.8148      213   43.7372   98.6111 OUL 
       3         3    0.6160    1.3889      216   44.3532  100.0000 LRH 
 ---------------------------------------------------------------------------------- 

 
Above a snap shot of the report Window in Pajek after creating a k-Neighpours-
Input-Partition and visualizing the Informations for this Partition is shown. 
Cluster 0 is Zurich. The 2nd column Freq is indication the amount of members of 
Cluster 1, 2 and 3. The members of Cluster 1, 2, respectively 3 are in one, two 
respectively three hops reachable from Zurich. 
 

7.11 Distribution of Distances to Zurich 
 
Frequency distribution of cluster numbers: 
 
 Cluster      Freq     Freq%    Valid%  CumFreq  CumFreq% CumValid% Representative 
 ---------------------------------------------------------------------------------- 
       0         1    0.2053    0.4630        1    0.2053    0.4630 ZRH 
       1        72   14.7844   33.3333       73   14.9897   33.7963 HEL 
       2       140   28.7474   64.8148      213   43.7372   98.6111 OUL 
       3         3    0.6160    1.3889      216   44.3532  100.0000 LRH 
 ---------------------------------------------------------------------------------- 

 
A snap shot of the report Window in Pajek after creating a k-Neighpours-Output-
Partition and visualizing the Informations for this Partition is shown. 
Cluster 0 is Zurich. The 2nd column Freq is indication the amount of members of 
Cluster 1, 2 and 3. The members of Cluster 1, 2, respectively 3 arrive in one, two 
respectively three hops in Zurich. 
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7.12 Line Values 
 
The most frequent air flight with 514 flights per week is from Barcelona to 
Madrid. It is followed with 505 flights per week by the connection from Madrid to 
Barcelona. The 390 flights from Monaco to Nice follow the previous. 
 
The distribution of the line values to the airports are illustrated because of the 
high amount of the lines in two figures in the appendix B. 
 
Again the logarithmic shape of the cumulated distributions curve stands out. 
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Figure 6-7: Cumulated Line Value Distribution as Percentage 
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7 Conclusion and Outlook 
 
This chapter contains the conclusion of this thesis. Additionally the contributions 
and an outlook on possible future works are presented. 
 

7.1 Conclusion 
 
In this thesis the static characteristics of the air traffic network over Europe are 
analyzed and so on a fundament for further dynamical statistics research is build. 
 
A flight schedule and a flight record build the data collections which are parsed 
and transformed into a common Pajek [8] network file format. 
 
In Pajek, software to analyze and illustrate large networks, static characteristics 
like indegree, outdegree and line value distributions are calculated and plotted. 
 
In analyzing the distributions we find out whether the network is random or 
scale-free. 
 
The distribution figures in chapter 6, Appendix A and B are showing a shape 
which indicates a power law distribution. The power law says that large is rare 
and small is common. 
 
Therefore it can be concluded that the European Air Traffic Network is scale free. 
 

7.2 Contributions 
 
The contributions of this semester thesis to design the air traffic network as a 
backbone for DTN Networks: 
 

• Acquirement of a flight schedule and record of the European Air Traffic 
 
• A parser and transformer of this data collections into Pajek Network Files 

 
• Static statistics of the European Air Traffic Network 
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7.3 Outlook 
 
The data collections in this semester thesis are covering the European Air Traffic. 
In order to enable a global delay tolerant network an acquirement of a global 
data collection should be possible. 
 
In this semester thesis the scope satisfied with analyzing static statistics. Both 
data collections include departure and arrival times of flights. In future 
researches the dynamic statistical characteristics of the European Air Traffic 
could be obtained and used to optimize a delay tolerant network using the air 
traffic as a backbone. 
 
Furthermore the flight records of Eurocontrol could be more useful for statistical 
research if they are better identified. A differentiation of publicly available and 
not accessible flights could be done. A record should be closer to reality than a 
flight schedule and build a better research fundament for delay tolerant 
networking. 
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A Draws of Pajek 
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Figure A-1: European Air Traffic Network 
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Figure A-2: European Air Traffic Network without Arcs 
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Figure A-3: Indegree Distribution of Airports 
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Figure A-4: Outdegree Distribution of Airports 
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B Distribution Figures IVT 
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Figure B-1: Indegree Distribution Amount of Airports 
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Outdegree Distribution
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Figure B-2: Outdegree Distribution Amount of Airports 
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Line Value Distribution 1st Part
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Figure B-3: Line Value Distribution 1st Part 
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Line Value Distribution 2nd Part
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Figure B-4: Line Value Distribution 2nd Part 
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C Distribution Figures Eurocontrol 
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Figure C-1: Indegree Distribution Amount of Airports 
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Figure C-2: Cumulated Indegree Distribution as Percentage 
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Outdegree Distribution
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Figure C-3: Outdegree Distribution Amount of Airports 

 



Distribution Figures Eurocontrol 

 53

Outdegree Distribution

0.00

20.00

40.00

60.00

80.00

100.00

0 10 20 30 40 50 60 70 80 91 102 114 124 139 158 181 213 242 309

Outdegree

P
er

ce
nt

ag
e 

of
 A

irp
or

ts
 S

um
m

ed

 
Figure C-4: Cumulated Outdegree Distribution as Percentage 
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Line Value Distribution 1st Part
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Figure C-5: Line Value Distribution 1st Part 
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Line Value Distribution 2nd Part
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Figure C-6: Line Value Distribution 2nd Part 
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Line Value Distribution
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Figure C-7: Cumulated Line Value Distribution as Percentage 
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